
บทท่ี 2 
เอกสารและงานวิจัยท่ีเก่ียวข้อง 

 
การวิจัยการแยกพยางค์เสียงพูดภาษาไทยด้วยไมโครคอนโทรลเลอร์ มีหัวข้อการศึกษา

เอกสารและงานวิจัยที่เกี่ยวข้อง เพื่อศึกษาข้อมูลต่างๆ ดังน้ี 
2.1 การแปลงสัญญาณจากอนาลอกเป็นดิจิตอล 

 2.2 การออกแบบขั้นตอนการท างานของโปรแกรม 
 2.3 วงจรส าหรับการแยกพยางค์เสียงพูดภาษาไทยด้วยไมโครคอนโทรลเลอร์ 

2.4 งานวิจัยที่เกี่ยวข้อง 
 
2.1 การแปลงสัญญาณจากอนาลอกเป็นดิจิตอล 
 คือระบบการแปลงสัญญาณ อนาลอกให้เป็นสัญญาณดิจิตอลซึ่งจะได้ค่าเท่ากับสัญญาณ
อนาลอก น้ันๆ 
 การแปลงสัญญาณจากอนาลอกเป็นดิจิตอลจะมีอุปกรณ์ที่ท าหน้าที่แปลงสัญญาณที่เรียกว่า 
A/D converter หรือ Analog to Digital converter โดยอุปกรณ์น้ีจะตรวจจับสัญญาณที่ได้จาก
หัววัดสัญญาณ จากน้ันจะแปลงค่าต่างๆ ที่สุ่มได้เป็นค่านับวัดในระบบดิจิตอลตามระดับที่ก าหนดด้วย
ค่า Bit ที่ใช้ เรียกการแปลงค่าน้ีว่า Digitization และค่า Bit ที่ใช้ในการก าหนดจ านวนระดับของค่า
ดิจิตอลหรือรายละเอียดที่ต้องการเรียกว่า Bit depth ซึ่งเป็นค่าบ่งบอกความละเอียดของสัญญาณ 
(Spatial resolution)  
 
2.1.1 Data sampling 
       การแปลงสัญญาณจากอนาลอกเป็นดิจิตอลจะถูกสุ่มค่าจากสัญญาณไฟฟ้าตามเวลาที่
เปลี่ยนแปลงไปซึ่งตัวเลขสุ่มที่ได้แต่ละค่าจะก าหนดเป็นระดับค่าดิจิตอลตามระดับเทียบเท่ากับระบบ 
bit ที่ใช้ซึ่งหากสุ่มจ านวนที่เหมาะสมพอดีค่าดิจิตอลที่ได้เมื่อน าไปแปลงกลับเป็นสัญญาณอนาลอกได้
สมบูรณ์มีรายละเอียดที่ครบถ้วน  แต่หากสุ่มน้อยเกินไปสัญญาณอนาลอกที่ไ ด้จะเกิดความ
คลาดเคลื่อนในการแปลง ท าให้สัญญาณอนาลอกผิดไปจากความเป็นจริง แต่ถ้าสุ่มจ านวนมากเกินไป
แล้วเมื่อน าไปสร้างสัญญาณอนาลอกแม้จะได้สัญญาณที่มีรายละเอียดต่างๆ สมบูรณ์เหมือนสัญญาณ
ต้นแบบแต่จะท าให้เวลาที่ใช้ในการประมวลผลมากเกินจ าเป็น ซึ่งความถี่ที่ใช้สุ่มข้อมูล (Sampling 
frequency) ที่เหมาะสมเรียกว่า  Nyquist frequency ซึ่งมีค่าเท่ากับ 2 เท่าของความถี่สัญญาณ 
input 
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ภาพท่ี 2.1 การสุ่มสัญญาณ อนาลอก เพื่อให้ได้ สัญญาณไม่ต่อเน่ืองทางเวลา 

 
 2.1.2 Aliasing 
       Sampling frequency เป็นความถี่ในการนับวัดสัญญาณที่เวลาใดๆ เพื่อแปลงค่าเป็น Digital 
signal   จะต้องมีความถี่เป็น 2 เท่าหรือมากกว่าความถี่สูงสุด ( fmax ) ของสัญญาณ เรียกความถี่น้ี
ว่า Nyquist frequency ถ้า Sampling frequency มีค่าน้อยกว่า Nyquist frequency จะเกิดการ
สูญเสียสัญญาณมาก (S/N ต่ า) สัญญาณอนาลอกที่ได้เกิดลักษณะที่เรียกว่า Aliasing artifact 
 
2.1.3 Shannon sampling theorem 
      “ An analog signal containing components up to a maximum frequency f-Hz may 
be completely by regularly spaced samples of 2f or twice the signal frequency” 
 
     จากหลักการดังกล่าวจะพบว่าอัตราการนับวัดสัญญาณ (Sampling rate; T) 
 
               T   =  1/2f 
 
ความถี่ที่น้อยที่สุดในการเก็บข้อมูลคือ  2f (Nyquist frequency) 
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2.2 การออกแบบข้ันตอนการท างานของโปรแกรม 
 การออกแบบขั้นตอนการท างานของโปรแกรมเป็นขั้นตอนที่สองการพัฒนาโปรแกรม ซึ่งจะ
ให้ผลเป็นแนวทางการป้อนรหัสโปรแกรม ผู้ออกแบบขั้นตอนการท างานของโปรแกรมอาจใช้เคร่ืองมือ
ต่างๆ ช่วยในการออกแบบ เคร่ืองมือชนิดหน่ึงที่นิยมใช้ออกแบบโปรแกรม เช่น ผังงาน (Flow chart) 
เป็นต้น 

ผังงาน (Flow chart) คือ วิธีการออกแบบโปรแกรมอย่างเป็นขั้นตอนและมีเหตุมีผล โดยการ
ใช้สัญลักษณ์และ ตัวอักษรประกอบการอธิบายในแต่ละขั้นตอน เพื่อให้ผู้เขียนโปรแกรมและผู้ สนใจ
ทั่วไปสามารถเข้าใจความหมายได้ ดังตัวอย่างที่แสดงไว้ในตารางที่ 2.1 

 
ตารางท่ี 2.1 ตัวอย่างของสัญลักษณ์ต่างๆ ที่มีใช้ในผังงาน 

 
สัญลักษณ์ รูปภาพ 

 
จุดเริ่มต้นหรือจุดจบของโปรแกรม (Terminal) 

 

ข้อมูลเข้า/ออก (Input/Output) 

 

การประมวลผล (Process) 

 

การตัดสินใจ (Decision หรือ Selection) 

 

ข้อมูลออก ทางจอภาพ (Display) 

 
ทิศทางของ ขั้นตอนการด าเนินงาน (Flow line) 

 
 ตัวอย่างผังงานของโปรแกรมการแยกพยางค์เสียงพูดภาษาไทยด้วยไมโครคอนโทรลเลอร์ ใน
ส่วนของการน าสัญญาณเสียงเข้ามาเก็บไว้ในหน่วยความจ า จะแสดงไว้ในภาพที่ 2.1  
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ภาพท่ี 2.2 ผังงานของการน าสัญญาณเสียงเข้ามาเก็บไว้ในหน่วยความจ า 
 

2.2.1 การป้อนรหัสโปรแกรม 
            การป้อนรหัสโปรแกรมเป็นการน าผลลัพธ์ของการออกแบบโปรแกรม ไปเปลี่ยนให้เป็น
โปรแกรมภาษาคอมพิวเตอร์ ภาษาใดภาษาหน่ึงผู้เขียนโปรแกรมจะต้องให้ความสนใจต่อรูปแบบค าสั่ง
และกฎเกณฑ์ ของภาษาที่ใช้เพื่อให้การประมวลผลเป็นไปตามผลลัพธ์ที่ได้ออกแบบไว้นอกจากน้ัน
ผู้เขียนโปรแกรมควรแทรกค าอธิบายการท างานต่างๆ ลงในโปรแกรมเพื่อให้โปรแกรมน้ัน มีความ
กระจ่างชัด และง่ายต่อการตรวจสอบและโปรแกรมน้ียังใช้เป็นส่วนหน่ึงของเอกสารประกอบ 
 
2.2.2 การทดสอบและการแก้ไขโปรแกรม 
 การทดสอบโปรแกรมเป็นการน าโปรแกรมที่ป้อนรหัสแล้ว เข้าคอมพิวเตอร์เพื่อตรวจสอบ
รูปแบบกฎเกณฑ์ของภาษา และผลการท างานของโปรแกรมน้ันถ้าพบว่ายังไม่ถูกก็แก้ไขให้ถูกต้อง
ต่อไป 
 
2.2.3 การท าเอกสารประกอบโปรแกรม 
 การท าเอกสารประกอบโปรแกรมเป็นงานที่ส าคัญของการพัฒนาโปรแกรม เอกสารประกอบ
โปรแกรมช่วยให้ผู้ใช้โปรแกรมเข้าใจ วัตถุประสงค์ ข้อมูลที่จะต้องใช้กับโปรแกรม ตลอดจนผลลัพธ์ที่
จะได้จากโปรแกรม การพัฒนาโปรแกรมทุกโปรแกรมจึงควรต้องท า เอกสารก ากับด้วยเสมอ 
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2.2.4 Keil uVision 3 
 คอมไพเลอร์ที่ใช้ในการพัฒนาคือ  โปรแกรม Keil uVison 3 หรืออาจเรียกว่า Keil C51 เป็น
คอ ม ไ พ เ ล อ ร์ ที่ ส ร้ า ง ขึ้ น โ ด ย บ ริ ษั ท  Keil Software ส า ม า ร ถ ด า ว น์ โ ห ล ด ไ ด้ ที่ 
http://www.keil.com ซึ่งที่ให้ดาวน์โหลดเป็นเวอร์ชั่นทดลองใช้ โปรแกม Keil uVistion 3 จะช่วย
ให้ เขียนโปรแกรม ด้วยภาษา C กับไมโครคอนโทรลเลอร์ตระกูล MCS51 ไ ด้ง่ ายและ 
รวดเร็ว โดยสามารถแปลงภาษา C51 เป็นโค้ด HEX ได้เลย 
 

 
 

ภาพท่ี 2.3 เป็นไอคอนของโปรแกรม Keil uVison 3 
 
2.2.5 ข้ันตอนการพัฒนาโปรแกรมด้วย Keil uVison 3 
ขั้นตอนที่ 1 การสร้างโปรเจ็ค  
1. คลิกเมนู Project > New ?Vision Project 

 
   
 เมื่อเลือกค าสั่ง New ?Vision Project จะปรากฏหน้าต่าง Create New Project ขึ้นมา 
โดยหน้าต่าง Create New Project จะก าหนดให้เราใส่ชื่อโปรเจ็ค ส าหรับใช้งาน ซึ่งในการท างาน
อาจมีหลายโปรเจ็คเพื่อความง่ายในการใช้งานควรสร้างโฟลเดอร์ (folder) ขึ้นมาใหม่แต่ละโปรเจ็ค
โดยเฉพาะ 

http://www.keil.com/
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2. คลิกปุ่ม  เพื่อสร้างโฟลเดอร์ใหม่ ในตัวอย่างต้ังชื่อโฟลเดอร์ว่า Project 
 

 
 
3. คลิกเข้าในโฟลเดอร์ที่สร้างใหม่ เพื่อสร้างโปรเจ็คในโฟลเดอร์น้ัน 
4. กรอกชื่อโปรเจ็คที่ช่อง File name:  

5. คลิกปุ่ม  เพื่อบันทึกไฟล์โปรเจ็ค 
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หลังจากที่บันทึกโปรเจ็คแล้ว โปรแกรม uVision 3 จะแสดงหน้าต่าง Select Device for Target 
'Target1' ขึ้นมา เพื่อให้เราเลือก ซีพียูที่จะใช้งานจาก Device Database  
 
6. เลือกซีพียูที่ต้องการ โดยในตัวอย่างเลือกซีพียู AT89C51 ของบริษัท ATMEL 
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ข้ันตอนท่ี 2 เขียนโค้ดโปรแกรม 
1. คลิกเมนู File > New หรือคลิกที่ปุ่ม   ที่แถบเมนู เพื่อสร้างไฟล์ที่จะใช้เขียนโค้ดโปแกรม 
2. เขียนโค้ดโปรแกรมที่หน้าต่างว่างตรงส่วนกลางของโปรแกรม uVision 3 (หน้าต่าง Text 1*) 

 
 
3. คลิกเมนู File > Save หรือคลิกปุ่ม   เพื่อบันทึกโค้ดโปรแกรม ถ้าเป็นการบันทึกคร้ังแรกโปรแกรม 
uVision 3 จะโชว์หน้าต่าง Save As ขึ้นมา เพื่อให้ต้ังชื่อไฟล์โค้ดโปรแกรม 

 
 
4. กรอกชื่อไฟล์ในช่อง File Name: โดยในตัวอย่างต้ังชื่อไฟล์เป็น Main.c 
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5. คลิกปุ่ม  เพื่อบันทึกโปรแกรม 
เมื่อสร้างโค้ดโปรแกรมเสร็จเรียบร้อยแล้ว จากน้ันให้เพิ่มไฟล์เข้าไปในโปรเจ็คของเรา 
6. คลิกขวาที่ Source Group1 ตรงหน้าต่าง Project Workspacs ถ้าหา Source Group1 ไม่เจอก็
ให้คลิกเคร่ืองหมาย + ข้างหน้า Traget 1 
7. คลิกเลือกเมนู Add Files to Group 'Source Group1' 

 
 
 จากน้ันหน้าต่าง Add Files to Group 'Source Group1' จะปรากฏขึ้นมาให้เราเลือกไฟล์ที่
จะเพิ่มเข้าไปในโปรเจ็ค 
8. คลิกเลือกไฟล์ที่จะเพิ่มเข้าไปในโปรเจ็ค 

9. คลิกปุ่ม  เพื่อเพิ่มไฟล์  
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ข้ันตอนท่ี 3 เลือก Tool Option ส าหรับซีพียู 
 โปรแกรม uVision 3 ให้เราสามารถก าหนดค่าพารามิเตอร์ต่างๆ ที่จ าเป็นส าหรับซีพียูที่เรา
จะใช้งาน โดยผ่านทางหน้าต่าง Option for Target ก่อนอื่นต้องเลือกซีพียูที่ต้องการใช้งานเสียก่อน 
ดังแสดงต่อไปน้ี 
1. คลิกเมนู Project > Option for Target 'Target 1' เพื่อเปิดหน้าต่าง Option for Target 
'Target1' 

 
 
หน้าต่าง Option for Target 'Target 1' จะปรากฏขึ้นมา ให้เราก าหนดพารามิเตอร์ต่างๆ ตาม
ต้องการ (แถบเมนูในหน้าต่างจะต้องอยู่ที Target ถ้าไม่อยู่ให้คลิกแถบ Target) 
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การก าหนดพารามิเตอร์ส าหรับซีพียูในส่วนต่างๆ มีรายละเอียดดังแสดงต่อไปน้ี 
     1.1 ก าหนดสัญญาณนาฬิกาของซีพียู ซึ่งจะมีค่าเดียวกับค่าความถี่ Xtal ที่ใช้ 
     1.2 ก าหนดว่าจะให้ใช้พื้นที่หน่วยความจ าเก็บโปรแกรมภายในชิปหรือไม่ ปกติจะก าหนดใช้
ภายในชิปไว้อัตโนมัติอยู่แล้ว ซึ่งก าหนดภายในไฟล์  
           STARTUP.A51 
     1.3 ก าหนด Memory Model หรือโมเดลพื้นที่หน่วยความจ า ปกติจะก าหนดเป็น Small 
     1.4 ก าหนหด Code Rom Size ส าหรับขนาดพื้นที่หน่วยความจ าที่จะเก็บโค้ดโปรแกรม ซึ่งเรา
อาจจะเก็บไว้สูงสุด 64K 
     1.5 ก าหนดพื้นที่ใช้งานหน่วยความจ าส าหรับเก็บโปรแกรมและข้อมูลไว้ภายนอกชิปทั้งหมด โดย
ให้เราใส่แอดเดรสเริ่มต้นและขนาดพื้นที่หน่วย 
           ความจ าที่ใช้ และใช้งานได้ถูกต้องควรท าการ Enable การใช้หน่วยความจ าภายนอกในไฟล์ 
STARTUP.A51 ด้วย 
2. คลิกแถบ Output เพื่อก าหนดค่าเอาต์พุต 
3. ใส่ชื่อไฟล์เอาต์พุต (ไฟล์นามสกุล.hex) ในช่อง Nane of Executable เพื่อให้ง่ายควรใส่ชื่อให้
เหมือนชื่อไฟล์โค้ดโปรแกรม ถ้าไม่ก าหนด โปรแกรม     uVision 3 จะต้ังชื่อเดียวกับชื่อโปรเจ็ค 
4. ก าหนดว่าจะให้โปรแกรม uVision 3 สร้างไฟล์ Hex หรือไม่ ถ้าต้องการให้คลิกที่ช่องว่างข้างหน้า 
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ข้ันตอนท่ี 4 Build โปรเจ็คเพ่ือให้ได้ไฟล์ Hex  
ในขั้นตอนน้ีเป็นการแปลงโค้ดโปรแกรมไปเป็นไฟล์ Hex ซึ่งมีขั้นตอนดังต่อไปน้ี 

     1. คลิกเมนู Project > Build target หรือคลิกปุ่ม  

 
 
ถ้ามีข้อผิดผลาดเกิดขึ้นโปรแกรม uVision3 จะแสดงข้อผิดผลาดและข้อความเตือนให้รับทราบที่หน้า 
Build ของหน้าต่าง Output Window และถ้าดับเบิลคลิกบรรทัดที่แสดงข้อผิดผลาดก็จะกระโดดไป
ยังโค้ดโปรแกรมที่ผิดผลาดน้ันทันที จากภาพตัวอย่างแสดงว่าบรรทัดน้ันมีข้อผิดผลาดสังเกตได้จาก
เคร่ืองหมาย ที่อยู่บรรทัดน้ัน 
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 จากตัวอย่างข้อผิดผลาดที่เกิดขึ้นก็คือ ฟังก์ชั่น delay_ms(1000); ไม่มีในการประกาศไว้ 
เมื่อแก้เป็น delay(1000); ให้ถูกต้องแล้ว ให้ท าการ Build target เหมือนขั้นตอนที่ 1 อีกคร้ัง 
โปรแกรม uVision 3 จะรายงานว่าไม่มีข้อผิดผลาดเกิดขึ้น 

 
 ผลลพัธ์ที่ได้ก็คือไฟล์ Hex หรือไฟล์นามสกุล .Hex น่ันเอง โดยไฟล์ Hex ที่ได้จะเก็บอยู่ใน
โฟลเดอร์โปรเจ็คที่ใช้งานปัจจุบัน สามารถน าไฟล์น้ีไปโหลดเข้าชิปไมโครคอนโทรลเลอร์ได้เลย 
 
2.3 วงจรส าหรับการแยกพยางค์เสียงพูดภาษาไทยด้วยไมโครคอนโทรลเลอร์ 
2.3.1 วงจรบอร์ดประมวลผลหลัก 
 วงจรส าหรับการแยกพยางค์เสียงพูดภาษาไทยด้วยไมโครคอนโทรลเลอร์ในงานวิจัยน้ี ได้
เลือกใช้ไมโครคอนโทรลเลอร์เบอร์ AT89C51AC3 ซึ่งมีฟังก์ชันการท างานส าหรับการแปลงสัญญาณ
อนาลอกเป็นดิจิตอลในตัว จึงไม่ต้องมีวงจรส่วนน้ีเพิ่มแต่อย่างใด วงจรที่ใช้แสดงดังรูปที่ 3 

 
 
ภาพท่ี 2.4 บอร์ดตัวประมวลผลที่ใช้ในการแยกพยางค์เสียงพูดภาษาไทยด้วยไมโครคอนโทรลเลอร์  
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ภาพท่ี 2.5 วงจรส่วนตัวประมวลผลที่ใช้ในการแยกพยางค์เสียงพูดภาษาไทยด้วย
ไมโครคอนโทรลเลอร์ 

 
2.3.2 คุณลักษณะของ MCU ตระกูล MCS51 เบอร์ AT89C51AC3 ของ ATMEL  
 ใช้แหล่งก าเนิดสัญญาณนาฬิกาแบบ Oscillator Module ค่า 29.4912 MHz ซึ่งสามารถ 
ก าหนดการท างานของ MCU ให้ท างานในโหมดความเร็ว 2 เท่า (X2 Mode) ได้ ท าให้ MCU 
สามารถประมวลผลด้วยความเร็วสูงสุดที่ 58.9824 MHz โดยคุณสมบัติเด่นๆของ MCU ได้แก่ 
 - มีหน่วยความจ า Flash ส าหรับเขียนโปรแกรมขนาด 64KByte 
 - มี EEPROM ขนาด 2KByte ส าหรับเก็บข้อมูล และ สามารถเขียนซ้ าได้กว่า 1 ล้านคร้ัง 
 - มีพอร์ต I/O ขนาด 8 บิต จ านวน 5 พอร์ต (P0,P1,P2,P3 และ P4(5Bit)) 
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 - มี RAM ใช้งาน 2304 Byte (ERAM 2048 Byte + IRAM 256 Byte) 
 - มีวงจรสื่อสารอนุกรม UART จ านวน 1 พอร์ต และมีวงจรสื่อสาร SPI จ านวน 1 พอร์ต 
 - มีวงจร Timer/Counter ขนาด 16 บิต จ านวน 3 ชุด 
 - มีวงจร ADC ขนาด 10บิต จ านวน 8 ช่อง (ใช้ Port-P1 โดยก าหนดจากโปรแกรม) 
 - มีวงจร Watchdog, Power-ON Reset, Capture/Compare ,PWM 

� มีขั้วต่อสัญญาณ I/O แบบ TTL แบบ Header 2x5 จ านวน 5 ชุด (P0,P1,P2,P3 และ P4) 

� มีขั้วต่อ LCD แบบ Header 2x7 รองรับการเชื่อมต่อกับ LCD Character (เชื่อมต่อแบบ 4 บิต) 

� มีขั้วต่อใช้งาน RS232 ส าหรับใช้งาน และ ET-DOWNLOAD ส าหรับ Download ผ่าน RS232 

� มี LED แสดงสถานะแหล่งจ่าย Power และ Self-Test ส าหรับใช้ทดสอบการท างานของบอร์ด 

� ใช้แหล่งจ่ายไฟขนาด +5VDC 

� ขนาด PCB Size เล็กเพียง 8 x 6 cm. 
 
2.3.3 วงจรการแสดงผล 
 วงจรส่วนแสดงผลใช้ส่วนแสดงผลเป็นชนิด LCD ขนาด 20 ตัวอักษร 4 บรรทัด จะแสดงได้
เฉพาะภาษาอังกฤษเท่าน้ัน พอร์ต CLCD ใช้กับ Character LCD เป็นการเชื่อมต่อแบบ 4 บิต โดย
สัญญาณที่ใช้เชื่อมต่อกับ LCD จะเป็นสัญญาณชุดเดียวกับที่ต่อไปยังขั้วต่อของ  PORT-P2 ในการ
เชื่อมต่อสายสัญญาณจากขั้วต่อของพอร์ต LCD ไปยังจอแสดงผล LCD น้ัน ให้ยึดชื่อสัญญาณเป็น
จุดอ้างอิง โดยให้ต่อสัญญาณที่มีชื่อตรงกันเข้าด้วยกันให้ครบทั้ง 14 เส้น 

 
ภาพท่ี 2.6 วงจรส่วนแสดงผล Character LCD 
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2.4 งานวิจัยท่ีเก่ียวข้อง 

ในการวิจัยคร้ังน้ี ผู้วิจัยได้ศึกษางานวิจัยต่างๆ  ที่เกี่ยวข้องเพื่อใช้เป็นแนวทางในการวิจัย โดย
มีรายละเอียดดังต่อไปน้ี 

สัญญา เครือหงษ์ (2546 : บทคัดย่อ) วิจัยเร่ืองการพัฒนาการแยกพยางค์จากข้อความ
ภาษาไทยเพื่อการสังเคราะห์เสียงพูด การแยกพยางค์ของภาษาไทยเป็นกระบวนการหน่ึงเพื่อ
จัดเตรียมหน่วยเสียงที่เหมาะสม ส าหรับการสังเคราะห์เสียงพูดจากข้อความ ในงานวิจัยน้ีผู้วิจัยได้
เสนอการแยกพยางค์จากภาษาไทย โดยใช้กฎเพื่อเปรียบเทียบหาโครงสร้างพยาง ค์ที่เหมาะสม 
(Suited-Syllable-Structure-Mapping: 3S-Mapping) วิธีการน้ีมีลักษณะที่ส า คัญคือจะใช้
โครงสร้างของพยางค์มาสร้างเป็นกฎ โดยกฎ เหล่าน้ีจะเร่ิมต้นจากการก าหนดโครงสร้างให้อยู่ในรูป
แบบอย่างง่ายที่ประกอบด้วย C V และ T ซึ่ง แทน พยัญชนะ สระ และวรรณยุกต์ตามล าดับ เรียกว่า 
สัญลักษณ์อักขระ (Alphabet-Symbols) โครงสร้างเหล่าน้ีจะต้องท างานร่วมกับการตรวจสอบกลุ่ม
อักขระไทย (Enhanced-Thai-Character- Cluster: ETCC) การพัฒนาด้วยวิธีการดังกล่าวจะเร่ิม
จากการแทนอักขระแต่ละตัวที่น าเข้ามาด้วย สัญลักษณ์อักขระ สิ่งที่ได้จากกระบวนการน้ีจะถูกน าไป
เปรียบเทียบกับกฎที่สร้างไว้และตรวจสอบ โครงสร้างที่เหมาะสมด้วยการตรวจสอบกลุ่มอักขระไทย 
นอกจากน้ีงานวิจัยน้ียังได้ใช้การแยก พยางค์ด้วยพจนานุกรมด้วยวิธีการเปรียบเทียบค าตามความยาว
ที่เหมาะสม (Suited-Length-Word Mapping: SL-word Mapping) เพื่อแยกพยางค์ที่อยู่
นอกเหนือจากกฎที่ออกแบบไว้ จากวิธีดังกล่าว ในการทดลองแสดงผลให้เห็นว่าการแยกพยางค์ด้วย
วิธีน้ีสามารถแยกพยางค์ได้ความถูกต้องถึง 99.85 % จากตัวอย่างทั้งหมด 4,000 ข้อความ 

 เฉลิมวุฒิ ไวชนะ (2548: บทคัดย่อ) วิจัยเร่ืองการชี้เฉพาะค าส าคัญเสียงพูด
ภาษาไทยบนพื้นฐานของการตรวจสอบหน่วยเริ่มและหน่วยตามของพยางค์  วัตถุประสงค์เพื่อพัฒนา
กรรมวิธีในการชี้เฉพาะค าส าคัญเสียงพูดภาษาไทยแบบไม่ขึ้นกับผู้พูดโดยการประยุกต์ใช้หลักการของ
แบบจ าลองฮิคเดนมาร์คอฟ ซึ่งเป็นแบบจ าลองของเสียงระดับย่อยของพยางค์ ใช้วิธีการตรวจสอบ
หน่วยเริ่มและหน่วยตามของพยางค์ มีจ านวนค าส าคัญ 70 ค าแบ่งออกเป็น 3 ชุดตามจ านวนคือ 20 
ค า 40 ค าและ 70 ค าเสียงพูดที่น ามาเป็นต้นแบบและเป็นแบบทดสอบประกอบด้วยเสียงผู้ชาย 30 
คนและเสียงผู้หญิง 20 คน ผลการทดสอบค่า FOM ของระบบการชี้เฉพาะแบบไม่ขึ้นกับผู้พูดมีอัตรา
เฉลี่ยร้อยละ ส าคัญ 54.45 โดยค่า FOM เฉพาะชุดค าส าคัญ 20 ค ามีค่าเฉลี่ยร้อยละ 64.59 ค่า FOM 
เฉพาะชุดค าส าคัญ 40 ค ามีค่าร้อยละ 51.11 และค่า FOM เฉพาะชุดค าส าคัญ 70 ค ามีค่าร้อยละ 
47.65 ตามล าดับ 

 จรัสแสง ผิวอ่อน และ ชาญวิทย์ ต้ังสิริวรกุล (2545 : บทคัดย่อ) ท าวิจัยโปรแกรม
ฝึกออกเสียงส าหรับคนหูหนวก โครงงานน้ีแบ่งการท างานของโปรแกรมฝึกออกเสียงส าหรับคนหู
หนวก ซึ่งเขียนด้วยโปรแกรม MATLAB สามารถแบ่งเป็น 3 ส่วนคือภาคอ่านไฟล์เสียงพูด ภาครู้จ า
เสียงพูด ภาคประมวลผลและแสดงผล โดยเสียงค าพูดเป็นแบบค าโดด (Isolated Speech) เสียงพูด
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จะถูกบันทึกในรูปแบบเวฟ (Wave Format) โดยผ่านทางไมโครโฟนที่ต่ออยู่กับการ์ดเสียง (Sound 
Card) ด้วยความถี่แซมปลิ้ง 11,025 Hz และความละเอียด 16 บิตต่อแซมปลิ้ง (Bits/Sample) 
จากน้ันได้น าข้อมูลวิเคราะห์หาความถูกต้องของเสียงพูด โดยขั้นแรกคือภาคหาจุดเร่ิมต้นและจุด
สุดท้ายของเสียงค าพูด โดยอ่านจากไฟล์เสียงพูด เพื่อน าเอาเฉพาะข้อมูลตรงส่วนที่เป็นสัญญาณเสียง
ค าพูดไปวิเคราะห์หาพารามิเตอร์ของเสียงพูด จากน้ันน าสัญญาณเสียงมาแปลงด้วยฟูริเยร์แบบเร็ว
และลดจ านวนข้อมูลลง เพื่อให้เหมาะสมกับการน าไปใช้งานในภาครู้จ าเสียงพูดต่อไป โดยแบ่งแกน
ความถี่ของสเปกตรัมของสัญญาณเสียงออกเป็นช่วง ๆ และท าการหาค่าเฉลี่ยของแอมปลิจูดในแต่ละ
ช่วงความถี่น้ัน ๆ โดยค่าเฉลี่ยที่ได้น้ีคือ ค่าพารามิเตอร์ที่ใช้แทนลักษณะเฉพาะของเสียงที่ต้องการที่มี
ทั้งหมด 46 จุด แล้วน าไปสู่กระบวนการตัดสินใจเสียงค าพูด โดยใช้นิวรัลเน็ตเวิร์คที่ได้รับการสอนแล้ว 
อ่านค่าน้ าหนักการเชื่อมต่อ และใช้สเปกตรัมของเสียงค าพูดเป็นรูปแบบอินพุต จากน้ันใช้ส่วนการ
ตัดสินใจแบบ logsig-moid มาใช้ในการตัดสินใจว่าเป็นเสียงค าพูดมีความถูกต้องหรือไม่พร้อมทั้ง
แสดงผลทางหน้าจอคอมพิวเตอร์ที่สร้างด้วยโปรแกรม MATLAB  ในตอนท้ายได้มีการทดสอบ
การแยกแยะเสียง noise แต่ละเน็ตเวิร์กโดยมีการปรับค่าอัตราการสอนที่ 0.5 ได้ความถูกต้อง 
64.5% และผลการทดสอบแต่ละเน็ตเวิร์คโดยมีการปรับค่าอัตราการสอนที่ 0.5 ส าหรับผู้ทดสอบคน
เดิมได้ผลเฉลี่ย 81.4% และผู้ทดสอบที่ไม่ได้ท าการสอนได้ผลเฉลี่ย 65.5% จากผลการทดลอง
ดังกล่าวได้ผลเป็นที่น่าพอใจ 

 


